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Contact and Support Information
Return to Table of Contents.

Product and account information can be accessed by visiting Customer Support online at
Support.CCH.com/Axcess. In addition to product and account information, the Customer Support site offers
answers to our most frequently asked questions, forms release status, Knowledge Base articles, training
videos, and operating systems compatibility for each CCH Axcess™ module. Access to these features is
available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find Support calendars, as well as options to enter Web tickets for assistance.
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Information in Tax Year 2014 Release Notes
Return to Table of Contents.

CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that have been made to Tax
products and systems with the current release.

The updates provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (such as, electronic filing updates, Organizer, roll forward, and
technology enhancements)
Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2014-5.0
Return to Table of Contents.

2014 Tax Updates

Corporation and S Corporation
New Jersey Corporation Business Tax Return

The following forms and schedules are available on this release. Be advised these have not been approved
by the State of New Jersey and all forms contain the "Approval Pending" watermark. We are making the
following available:

2014 New Jersey Corporation Form CBT-100
2014 S Corporation Form CBT-100-S
Associated schedules for corporations with 2014 fiscal years ending after June 30, 2015

New Jersey requires all forms be approved by the State of New Jersey's Division of Taxation prior to release
for filing. These forms should not be filed under any circumstances.

2014 Tax Program Highlights

Organizers
Individual and Fiduciary Organizers are now available for processing.

Return Configuration Sets

Backup/Restore. You now have the ability to backup and restore your return configuration
sets.
Correspondence > Customize Margins. You can now adjust your letter template margins at
the return configuration set level.

Note: This does not apply to filing instructions, Organizer mailing sheets, or Organizer question
pages.

Diagnostics Panel
We no longer close the diagnostics window each time you calculate; it will now remain open.

Worksheet Features
Dialogs

When accessing a list, defining a keyword, viewing a statement, or uploading to the Electronic
Filing Status system, you will no longer be blocked from opening another return or another
application in CCH Axcess.
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Zoom In/Out

You will now be able to zoom in and out in worksheets like you can in government forms. This
lets you adjust your view as desired.
Your selection will be saved.

Gripper control. You will now be able to adjust panes much more easily in either worksheets or
government forms, and we will save your selection.

Navigation panel. The pane/bottom scroll bar no longer shifts as you scroll down the tree past an item with
a long description.

Return Manager

Gripper control. You will also be able to more easily adjust the pane in Return Manager.
Client Search filters. We added filters to the column headings in the Client Search view, so
you can filter the results of your searches as desired – by year, return type, etc. This is specific
to Client Search only.
e-file status. Fields in the e-file Status column are not editable.

Correspondence
Save letter with Return. To improve performance, we removed the “Save letter with return and as a
template to the library“ option. When the user selects to "Save from within the return," we no longer display
this dialog.

Letter and filing instruction spacing. Identified spacing issues are resolved in the letter and filing
instructions.

Batch Manager
Print Organizers to PDF

We added a new option to name Organizer PDF files by ‘Name and ID’ in addition to ID.
We changed the Client Data default to “Use client information from return” rather than “Use
client profile.”

Return Selection. You can now view a column for Return Status when selecting returns for Organizer and
Roll Forward.

DataScan

Added an option to mask all but the last four digits of the SSN in reports.
When working on the Copy Scan, Submit Scan or Build Scan dialogs, you will no longer be
blocked from using the rest of the Suite. You will be able to access a return or another
application.
Added an option to hide canned searches from the scan list.
For clarity, we added hover text to ‘operators’ within the search criteria.
We centered all date fields in the Results Report.
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Tax Product Updates

Individual (1040) Product Updates
Return to Table of Contents.

Federal
Links from federal government forms to the official IRS government forms & instructions are updated.

Alternate Filing Instructions will mention Form 8886 when it is present in the return and the federal return is
being electronically filed.

Form 6251. If neither the Qualified Dividend and Capital Gain Tax Worksheet or the Schedule D Tax
Worksheet are prepared for regular tax purposes and Form 2555 is included in the return, Form 6251, Line
51, equals Form 6251. Line 44.

Kentucky 4952-K, Line 5, calculation matches the result of the white paper statement that prints for that
line.

Schedule J. When the taxable income, for 2013, is less than the capital gains and a portion of the capital
gains is taxed at 20%, the sum of the capital gains taxed at 0%, 15% and 20% is limited to the taxable
income.

Alabama
The extended due date flows to letters and filing instructions.

Arkansas
AR1000D correctly handles loss and gains on Schedule D.

Kentucky
Kentucky Form 8863-K produces in the return for nonresident and part year filers when an amount appears
on Kentucky 740NP, Line 23.

Mississippi
Form 80-401, Broadband Technology Credit allows carryover from prior year.

New Jersey
NJ Form 2450 fills from Expatriate wages.

New York
The amount paid with Form IT-370 flows to the main form and related places when the print has been
suppressed.
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Ohio
Forms IT 2023 and IT SBD line 9a use the maximum Keogh, SEP and SIMPLE deduction calculation rather than
the input amount when both entries are present on Keogh, SEP and SIMPLE Plans > Identification Data
(Interview Form M-6).

Late payment interest and penalty calculate from the original due date of the return regardless of the
extended due date.

Ohio Cities
Alternate Filing Instructions. Ohio city returns with a current year refund but a balance due when including
the first quarter estimate on the return no longer receive paragraphs for both a balance due and a refund.

Pennsylvania
Pro Forma of Pennsylvania Limited Liability Company Tax Report worksheet > RCT-101 Corp Tax Report -
Sections A, B, and C section > Oldest period through current period fields properly carries dates and amounts
forward to next tax year.
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Partnership (1065) Product Updates
Return to Table of Contents.

Federal
Links from federal government forms to the official IRS government forms and instructions are updated.

Form 4562 (attachment to Form 8865), Line 20a, convention information, is now included in the electronic
file.

Form 8858, Line 3b, now defaults to print "United States" as country of incorporation when no input for
country is present.

Form 8865 when created out of Form 1065 and additional 8865s are also present, Schedule B, other
deduction statement will now match with corresponding 8865.

Partnership Basis Activity now includes Portfolio deductions on Line 10g.

Passthrough Statement for California no longer add the DPAD W-2 Wages to every passthrough when it should
be for only one passthrough.

Personal exclusion from rental real estate with vacation home exclusion is now reflected on the Schedule M-
3 statement as a permanent difference.

Schedule K-1 Multiple Activity Statement now allows negative dividends and matches the Schedule K and
Schedule K-1.

Schedule K-1, Part L, Beginning Capital allows the override entries to flow to the Schedule K-1 properly.

Schedule K-1 Depletion from oil and gas entered for a passthrough now flows to Line 20T of the Schedule K-1
with or without an activity number.

Special Basis for Schedule K-1 now uses special allocation code 5667 and flows to Line 20M.

State form equivalents of Federal Form 8903 can now be suppressed by entering zeroes in
Income/Deductions > Domestic Production Activities Deduction Other Information > 3-Overrides > 19-State
if Different Information.

The amounts in the accrual section of Schedule F now clear when the option to use the accrual method is
removed.

Arizona
AZ Schedule K-1 NR, Line 1, now picks up federal Schedule K-1 ordinary income when special allocation is
used on income that includes ordinary income (loss) from passthrough entites.

Form 120EXT now shows on the federal Extension Information Report when the extension is present in the
return.

California
Exempt organization is selected for the entity type on Schedule K-1 (565) and (568) if type H is entered on
Federal > Partners > Partner Summary.

Form 592-B is no longer produced when Form 3832 has been produced using California > General Information
> Options > Form 3832 processing code.
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Form 592 (2014) no longer picks up special allocations of the portfolio deductions subject to 2% floor
override entered on California > Income / Deductions > Schedule K Other Adjustments / Overrides.

Schedule K, Line 17a, picks up state if different amounts from passthroughs when CA is not the home state.

The description for other tax-exempt interest and nondeductible expense is updated to read 'from
passthrough' instead of 'from multiple activity schedule'.

The federal override for Section 1256 contracts and straddles on Income / Deductions > Schedule K - Income
/ Deduction Overrides > Schedule K Income Overrides now overrides the amount entered from passthroughs.

The transmittal letter and filing instructions for Form 592 (2014) is produced if 2015 Form 592 is suppressed.

California Electronic Filing
Disqualifying diagnostic 48314 is modified to prevent returns from filing with 1 partner entered for Form
565, Page 2, Line K.

Delaware
Schedule K-1, Line 11, Column B, now allows a zero to print when applicable.

Kentucky
KY Schedule K-1 allocates using 765 Schedule K information when 765 Schedule K overrides are used for 2%
portfolio deductions.

Massachusetts
Extension Form M-4868 is updated to generate when Other > Extensions > State Extension Information >
State Code has "MA" entered.

Michigan
The Form 807 Schedule K-1 equivalent, "Michigan allocated income (loss): Income attributable to other
Michigan Partnerships, S corporations and fiduciaries", line will only calculate if there is an amount on Form
807, Page 2, Line 38.

Nebraska
Form 1065N, Line 10, calculates per form instructions. Schedule II, Column G, fills from 1065N, Line 10, if
a rounding difference exists. A notice is posted at the bottom of Schedule II if this is the case.

New Hampshire
The Form DP-10 refund box is now selected when Form DP-10, Line 17b, contains an amount.

New Mexico
The disqualifying diagnostics for PTE-B issues correctly for positive or negative amounts in Column 1 or 2.

New York - New York City
Form NYC NOLD-UBTP, Line 3, now generates a statement when there is more than one previously absorbed
allocated item input.
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Rhode Island
Form RI-1096PT-ES voucher overrides of zero are now recognized.

Rhode Island Electronic Filing
The first partnership name line on the RI K-1 is always filled.

Utah
Utah Schedule N, Line E, calculation is updated to not automatically back out health insurance premiums
when guaranteed payments are not UT sourced.

Vermont Electronic Filing
Disqualifying diagnostic 48633 issues when Form K1VT is not present or the print is suppressed.

Form K-1VT no longer issues a schema validation error when all nines are entered as the entity or
individual's identification number.
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Corporation (1120) Product Updates
Return to Table of Contents.

Federal
Links from federal government forms to the official IRS government forms & instructions are updated.

Multiple total everywhere entries can now be made for the state intercompany elimination at the
consolidated level. Expanded input is now available via input on State Inter-company Apportionment
Elimination > Total Everywhere Override - Sales Factor worksheet , Total Everywhere Override - Property
Factor and Total Everywhere Override - Payroll factor.

The amount on Form 4562 for business income limitation for section 179 expense deduction now corresponds
to the taxable income on the return when Form 8926 limitation applies.

Consolidation
Dormant subsidiary question on the consolidated Schedule M-3, Part I, is now checked when Schedule M-3,
Parts II and III are not required.

When the Elimination Company Method is used, the elimination company now only appears once on the
Consolidated Beginning Balance Sheet workpaper when more than four companies are present.

Alaska
The address change check box is marked only when a change of address is indicated.

Arizona
AZ Form 120, Sch B, Line B3, no longer includes 20% of the 2013 179 deduction entered in
Income/Deductions > Subtractions > 2013 federal IRC Sec 179 disallowed by Arizona, per instructions.

Form 120, Line 14 (Arizona NOL), is now limited to the gain on Line 13.

Form 120, Section E, Line E3 f, has the correct factor applied (2 or 85) when there is only sales entered for
apportionment.

In a consolidation return for AZ, Form 120, Page 3, Schedule E, Line E3f, now properly doubles the sales
factor when there is an intercompany sales elimination entered in State Apportionment Elimination - Sales
Factor.

Arizona Consolidated
Schedule MSP may now be prepared in the combined or consolidated Arizona return.

California
Data input for 3805Z credit assigned from other entities is added.

Schedule D-1, Line 11, is updated to always print as a positive number.

The California transmittal letter suppresses Form 3520 information, if the option to suppress Federal Form
2848 is selected.
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California Combined
Form 3544, Election to Assign Credits Within Combined Group Reporting, Column (c), Certificate Number, is
updated to allow entries other than the six digit federal business code.

Illinois
Federal 1120-REIT, 1120-F, 1120-IC-DISC, 1120-RIC, 1120-REIT, 1120-C, and 1120-FSC are now included in
the government copy when used instead of the Federal 1120.

Kentucky Electronic filing
A diagnostic is issued when an Alternative 1120 is present. The Kentucky return must be paper filed.

A diagnosticis issued when KY Schedule A, Schedule A-C check box indicator is NOT checked and Section I,
Line 6, is not equal to Section IV, Line 9.

Electronic filing diagnostics 46932 for KY Schedule A percentages does not issue when percentages match.

Electronic Filing KY Schedule AC now picks up the entity as Name 1 when only one name is entered.

The KY 720SL KY Acct number is picked up in the electronic file.

Maine
Form 1120ME, the check box for Form 990T no longer checks when Basic Data > General > Line 23 is
present.

Massachusetts
The Massachusetts Dept of Revenue updated Form MA AA-1. The calendar year no longer prints on the form.

Michigan CIT Electronic Filing
Form 4910, Page 2, Part 2B, the amounts on Lines 14, 15, 16, 17 and 19d are limited to zero. Negative
amounts are no longer printed on these lines.

The electronic filing diagnostic 46372 disqualifying the Michigan CIT UBG return for missing Form 4911 is no
longer issued if the form has been generated in the return.

The electronic filing diagnostic 48320 disqualifying the Michigan CIT UBG return for missing Form 4898 will
no longer get issued if the form was generated in the return.

Michigan
The CIT Form 4891, Line 15b cross-refernce is updated to reference the correct line on CIT Form 4897.

The CIT Form 4899, Line 1, fills the current year total tax liability on either CIT Form 4891, Line 43, or CIT
Form 4905, Line 41, or CIT Form 4908, Line 22, when there is Michigan prior year tax of $800 or less
entered under Federal > Payments/ Penalties > Penalties > State city underpayment penalty.

Mississippi
Form 83-310 overflows to Page 2 on the sixth consolidated company.
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Montana
An adjustment was made to ensure the amount on the Schedule K Combined, Line 6a, matches the
calculated amount on the Form CIT, Page 3, Line 4.

Nebraska Combined
Additional sheets of the Schedule of NE Combined Adjusted Federal Income now prints correctly.

New Jersey
New Jersey Corporation Business Tax Return. The following forms and schedules are available on this
release. Be advised these have not been approved by the State of New Jersey and all forms contain the
"Approval Pending" watermark. We are making the following available:

2014 New Jersey Corporation Form CBT-100
2014 S Corporation Form CBT-100-S
Associated schedules for corporations with 2014 fiscal years ending after June 30, 2015

New Jersey requires all forms be approved by the State of New Jersey's Division of Taxation prior to release
for filing. These forms should not be filed under any circumstances.

New York
A correction was made to CT-3 transmittal letter/filing instructions to indicate direct deposit was used
when a return has a balance due and refund.

Effective for tax years beginning on or after January 1, 2015, the New York City fixed-dollar minimum tax
has additional brackets pertaining to taxpayers with more than $50 million New York City receipts. The
increase does not apply to S Corporation filers. The 2014 program is updated to reflect these changes, as
they pertain to year 2015 estimated tax. If your client’s 2015 New York City estimated tax was prepared
based on the fixed dollar minimum tax and New York City receipts were in excess of $50 million, you may
want to review the C Corporation’s estimated tax payments to minimize or avoid potential underpayment of
estimated tax penalties. For your convenience, the additional brackets are shown below.

If New York City receipts are: Fixed dollar minimum tax is:
More than $50,000,000 but not over $100,000,000 $10,000
More than $100,000,000 but not over $250,000,000 $20,000
More than $250,000,000 but not over $500,000,000 $50,000
More than $500,000,000 but not over $1,000,000,000$100,000
Over $1,000,000,000 $200,000

North Carolina
When special apportionment is requested on CD-405, Sch O, Part 4, the values previously entered for Part 2
are removed.

North Carolina Electronic Filing
A modification was made to the input of corporate officers that ensures changes in offices do not cause
schema validation errors.
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Adjustments were made to the Schedule O for electronic filing purposes to help ensure a valid electronic file
is submitted.

An adjustment has been made to ensure the proper energy type is included in the electronic file when filing
Form 478G.

Rhode Island
Line 19 of Form T-74, Page 1, is updated to accurately reflect overpayment credited to next year's tax.

South Carolina Consolidated
Federal NOL on SC1120, Schedule A, now flows correctly up to the consolidated return from the sub and
parent returns. Thus, the Schedule A and B net adjustments on Page 2 now match Page 1, Line 2.

SC1120. Page 1, Line 23, now calculates correctly on the consolidated return, along with the combined
balance on the 'Schedule of combined taxable income and license fee.'

Texas
Texas Form 102 Expiration date no longer pulls Federal and State codes from entities other than Texas.

Utah Electronic Filing
Utah Electronic Filing diagnostic #45451 no longer issues in error when a foreign address is entered.

Vermont
Combined unitary returns pull the depreciation adjustment from the Cons/Combined worksheets to Line 2 of
the VT CO-411. The recomputed income statement also prints in these returns with a designation referring
to the consolidated combined depreciation adjustment.

Wisconsin
In Form 6 returns, subsidiary returns for insurance corporations filing a federal 1120-PC show the amount
from 1120-PC, Schedule E, Line 7, on Form 6, Part I, Line 1, and the amount on Form 6, Part I, Line 26
includes the amount from the 1120-PC, Schedule F, Line 14.

Wisconsin Electronic Filing
Form 6 returns pass schema validation if members of the federal consolidated return are excluded from the
Wisconsin combined group.
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S Corporation (1120S) Product Updates
Return to Table of Contents.

Federal
Amortization assets no longer have rounding errors for certain lives when calculating amortization.

Portfolio deductions subject to 2% limitation from passthrough entities are now properly carried to Line 4 of
Form 6198.

Links from federal government forms to the official IRS government forms and instructions are updated.

The composite return balance due paragraph no longer has an extra blank line at the end.

The federal amended transmittal letter now produces when separate federal and state letters are requested.

The filing instructions for Wisconsin Form PW-1 now properly indicate that the form is being electronically
filed.

Alabama
The Form PPT mailing address is updated for returns with no payment due.

Arizona
Form 308, Line 5, is blank when Line 3 is checked "No",

California
Printing of Form 592 quarterly withholding is enhanced to contain proper printing of the shareholder's name
when the shareholder is a grantor trust.

California Electronic Filing
Disqualifying diagnostics related for Form 592-B is no longer issued if the form is not present in the return.

Schedule R, Line 1a, will be zero when no amount is present, as required by electronic filing.

Massachusetts
The Massachusetts Dept of Revenue has updated Form MA AA-1. The calendar year no longer prints on the
form.

Mississippi
Form 83-120, Schedule M-1, Line 7, matches the federal return.

Montana Electronic Filing
A modification was made to ensure that overrides for royalties and interest income do not allow for
negative values to be entered, as these are not allowed when electronically filing.

New Hampshire
The FEIN number can no longer be accessed on the Combined Schedules.
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New Mexico
A disqualifying diagnostic issues when the date entered for automatic withdrawal is earlier than the current
date.

New Mexico Electronic Filing
The transmittal letter and filing instructions print with the government copy of the return when electronic
filing is active for New Mexico

New York
You can now access apportionment overrides for NYC.

An update was made to transmittal letters to show the refund amount from Line CT-3S.

New Jersey
New Jersey Corporation Business Tax Return. The following forms and schedules are available on this
release. Be advised these have not been approved by the State of New Jersey and all forms contain the
"Approval Pending" watermark. We are making the following available:

2014 New Jersey Corporation Form CBT-100
2014 S Corporation Form CBT-100-S
Associated schedules for corporations with 2014 fiscal years ending after June 30, 2015

New Jersey requires all forms be approved by the State of New Jersey's Division of Taxation prior to release
for filing. These forms should not be filed under any circumstances.

Ohio
Form IT-4708 (fiscal year version), Composite Income Tax Return for Certain Investors in a Pass-Through
Entity. Software is updated to include all changes. However, the Ohio Department of Taxation has not
approved the substitute forms yet. Accordingly, there will be an "Approval Pending - Do Not File" patch on
Form IT-4708 until the forms are approved.

The small fonts option is no longer allowed on Form IT-4708, Page 3, and the program no longer closes.
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Fiduciary (1041) Product Updates
Return to Table of Contents.

Federal
Form 3115 statements print directly behind Form 3115, Page 8.

The NOL carryforward carried to next year for Nebraska in a non resident return will be the amount on the
Nebraska NE NOL, Page 2, Line 36, less Line 33.

Pro Forma
Pro Forma accurately reflects prior year taxes paid in current year for refund returns with an extension
payment and an underpayment penalty.

Alabama
Filing instructions no longer include interest and penalties twice when electronic filing is elected,
deselected, and reselected.

New Jersey
Late payment penalty and interest now calculate without regard for any extended due date entered or
calculated.

Oklahoma
Returns that include Oklahoma now prints Schedule C and Schedule F properly.
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Estate & Gift (706/709) Product Updates
Return to Table of Contents.

Minnesota
The 2015 Minnesota Form M706 was added.

New York
When the decedent’s date of death is between 1/1/15 and 3/31/15, the attorney and executor name and
address now print on Form ET-133.
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Exempt Organization (990) Product Updates
Return to Table of Contents.

Federal
Schedule H diagnostic 17420 will no longer be issued if the '999' Line Number code is being used on the
Federal > Schedules > Schedule H - Hospitals worksheet to report facility reporting groups.

The 990-T extended due date now prints on the Federal 990-T custom filing instructions under “Return Must
be Mailed On or Before” section when the option to print the extended due date on the letters and filing
instructions is selected, while the words, "As soon as possible" only print when the option to print the
extended due date on the letters and filing instructions is not selected and return due date has passed.

The check box questions on Schedule H, Page 5, Lines 13(b) through (h) will now be answered when the
corresponding input is present on the Federal > Schedules > Schedule H - Hospitals worksheet.

The Form 3115 paragraph on the 990 transmittal letter is no longer suppressed when the option to suppress
the extension letter is entered in the General > Letters and Filing Instructions > Transmittal letter >
Extension transmittal letter option.

The government form description for Schedule H, Page 6, Line 20f, is corrected. The word 'Non' is corrected
to 'None.'

The hospital facility information reported on Schedule H, Page 3, no longer skips lines when a state license
number being reported exceeds 20 characters.

The question on Form 990-T, Page 2, Part 5, Line 1, is now answered as "Yes" if an entry is made to indicate
that the organization has had an interest in or a signature or other authority over a financial account in a
foreign country during the calendar year.

Electronic Filing
A disqualifying diagnostic now issues if the organization's street address exceeds 35 characters (per new IRS
business rule R0000-197).

Electronic filing diagnostic 47633 is no longer issued indicating an invalid email address when the
organization's corresponding email address ends with .NYC
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Issues Addressed
Return to Table of Contents.

Issues for the following CCH Axcess™ Tax features were resolved and are included in release 2014-5.0.

Correspondence Manager
You can now select to delete multiple paragraphs. (128765)

Import/Export
The Quiklink option is available in government forms as well as worksheets. (125342)

Tax no longer closes unexpectedly when opening BNA after a completed export. (131925)

Print
Returns with a combination of a page break and line wrapping correctly print. (122370)

Lines in the Summary page of the K-1 Passthrough report no longer print off the page. (126557)

The presentation of K-1 footnotes is consistent when printed. (129925)

Tax
Signer fields are updating correctly based on input. The General > Return Options > Preparer Information >
Preparer Name value is correctly updated to match the value in the Individual Preparer Code field
immediately after moving the focus from the latter field. (104119)

Electronic filing status is correctly shown in Return Manager. (122992)

Scrolling in a grid no longer causes amounts to disappear. (124123)

Adding a state to a Partnership passthrough activity is no longer causing slow performance. (131284)
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